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Overview

Networks have long been used to represent important biological processes. Many of us remember
memorizing the Krebs (TCA) cycle, which is usually shown as a directed graph, itself a type of network
(Figure 1). Recently, however, the use of networks in biology has changed from purely illustrative and
didactic to more analytic, even including hypothesis
formulation. This shift has resulted, in part, from the
confluence of advances in computation, informatics,
and high-throughput techniques in systems biology.
Today the analysis and visualization of biologically
relevant networks has become commonplace, whether
the networks represent metabolic, regulatory, or
signaling pathways; protein-protein or genetic
interactions; or more abstract connections between
similar proteins or similar ligands. Networks are now
routinely used to show relationships between
biologically relevant molecules, and analysis of those
networks is proving valuable for helping us understand
those relationships and formulate hypotheses about
biological function.

Figure 1. The TCA cycle from WikiPathways

With the advent of high-throughput methods that generate vast amounts of data from diverse
measurement sources — for example gene expression data from microarrays, protein or metabolite
abundance from mass spectrometry — biological networks have become increasingly important as an
integrating context for data. As a commonly understood diagrammatic representation for concepts and
relationships, networks provide structure that helps reduce underlying complexity of the data. Network
tools give us functionality for studying complex processes. We can analyze global characteristics of
the data, via metrics such as degree, clustering coefficient, shortest paths, centrality, density. We can
identify key elements (hubs) and ‘interesting’ subnets, which can help us to elucidate mechanisms of
interaction. Also, visualization of data superimposed upon the network can help us understand how a
process is modulated or attenuated by a stimulus.

Network tools have proven to be extremely useful in
analyzing and visualizing important biological processes.
Some general applications of networks in biology include:

* Gene Function Prediction — Examining genes ' = G
(proteins) in a network context shows connections AR
to sets of genes/proteins involved in same
biological process that are likely to function in that
process [1-4].

Figure 2. Gene Function Prediction using
jActiveModules
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Detection of protein complexes/other modular structures — although interaction networks
are based on pair-wise interactions, there is clear evidence for modularity & higher order
organization (motifs, feedback loops) [5-9]
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Figure 3. ldentifying molecular complexes in large protein interaction
networks using MCODE

Prediction of new interactions and functional associations — There are several methods for
predicting interactions and functional associations, based upon network structure and
correlations amongst data. For example, orthology-based methods have been used to predict
interactions for a species based upon orthology to interacting pairs of proteins in evolutionarily
similar organisms[10]. Other researchers have used Bayesian network approaches to inferring
gene regulatory networks from time course gene expression data[11]. In another approach,
shown on the example below, statistically significant domain-domain correlations in protein
interaction network suggest that certain domain (and domain pairs) mediate protein binding.
Machine learning extends this to predict protein-protein or genetic interaction through integration
of diverse types of evidence for interaction [12-14].
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Figure 4. Visualizing domain interactions and alternative splicing
using DomainGraph
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Moreover, these same tools and their associated analysis and visualization methods can provide key
insights in the study of disease and in drug development. These include:

+ Identification of disease subnetworks — identification of disease network subnetworks that
are transcriptionally active in disease. These suggest key pathway components in disease
progression and provide leads for further study and potential therapeutic targets [15-20].

Figure 5. Gene expression profiles and American Heart Association (AHA) histological
classification of atherosclerotic lesions (left panel). Differentiation scores were calculated for
all genes across pairwise conditions (e.g. diabetic vs. non-diabetic patients). A large literature
network was built for atherosclerosis. Connectivity analysis was used to extract a
transcriptionally-active subnetwork for diabetic vs. non-diabetic conditions (right panel).

+ Subnetwork-based diagnosis — subnetworks also provide a rich source of biomarkers for
disease classification, based on mRNA profiling integrated with protein networks to identify
subnetwork biomarkers (interconnected genes whose aggregate expression levels are
predictive of disease state[21, 22]).
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Figure 6. A network-based approach identified prognostic markers not as individual genes but
as subnetworks extracted from molecular interaction databases. Gene expression profiles
from Chronic Lymphocytoic Leukemia patients were mapped to a large human molecular
interaction network. A search over this network was performed to identify prognostic
subnetworks that could be used to predict treatment-free survival.
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+ Subnetwork-based gene association — molecular networks will provide a powerful framework
for mapping common pathway mechanisms affected by collection of genotypes[23, 24].
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Figure 7. Cytoscape Mondrian plugin with a dataset
derived from the TCGA Glioblastoma Pilot Project. This
dataset contains mutations, copy-number alterations,
and expression data for 91 samples.

For the purposes of this tutorial, we will classify
biological networks into three major categories:
pathways, similarity networks, and interaction
networks.
and signaling networks. Figure 2 shows a pathway
containing genes involved in glioblastoma
multiforme, a major form of brain cancer [25].
These genes were identified by a large-scale
genetic analysis of copy number variation and
genetic changes in 206 glioblastoma multiforme
patients. The study was conducted as part of The
Cancer Genome Atlas (TCGA) project. Notably,
the study demonstrated that there was no single
genetic defect responsible for glioblastoma
multiforme, but that all of the cases showed
significant pathway changes — strongly suggesting
that this form of cancer is a “pathway disease.”
From a visualization standpoint, the real power is
the ability to map expression, mutation, or copy

Pathways include metabolic, regulatory,

Figure 8. Partial pathway showing genes implicated
in glioblastoma multiforme colored by the changes
in copy number
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number variation data onto pathways to reveal (or suggest) how the pathway and its components
function under different sets of conditions, including disease states. Thus, the ability to analyze a
variety of data sources and types and to map that data onto pathways is crucial. There are also
techniques for deriving putative pathways from expression data' and for modeling the kinetics of
biological processes [26] that are beyond the scope of this talk.

Interaction networks comprise the second
category. In these networks, nodes represent
biological entities and edges represent some
form of interaction or relationship. A common
example of this type is a protein-protein
interaction (PPI) network. Figure 3 shows a
yeast protein-protein interaction network
generated by tandem affinity purification
followed by mass spectrometry (TAP/MS) [27].
Analogous networks have been generated
based on ligand similarities [28], protein
similarities [29], and drug-target networks [30].
Generally, this class of biological networks can
present as a “hair ball”, where there is so much . . . o .

. . . . . Figure 9. Partial protein-protein interaction network
|n_fc_>rmat|on _that the mean_mngI relatlonshlps are for Saccharomyses cerevisiea colored by predicted
difficult to discern. There is good evidence that complexes.

analysis of a PPI network to find highly

connected “hubs” can be used to predict protein complexes [8], and clustering of protein similarity
networks can provide clues to protein family (and hence functional) assignments (Figure 4).

A variety of analytical techniques can help to elucidate interaction networks. Clustering methods such
as MCL [31] have proven valuable, although several algorithms more specific to various types of
interaction networks have also been developed (c.f.[5]. In addition to clustering, a variety of metrics
can be applied to an interaction network or nodes within the network. The average density (node
degree) of the network, average shortest-path distance,
number of connected components, measures of centrality,
and the extent to which the network fits a scale-free model
are all useful descriptors for the analysis of an interaction
network. Altering the layout and visual attributes of the
network can also be helpful.

Cytoscape is an open-source application for the
visualization and analysis of (biological) networks. During
my talk, | will use Cytoscape to demonstrate some of the
techniques for visualizing and analyzing biological
networks. In addition, | will demonstrate some ways that
biological networks can be combined with other data to
help elucidate function or the possible implications of
changes in biological function due to perturbation,
mutation, or infection.

Figure 10. Protein similarity network of the
amidohydrolase enzyme superfamily colored
by subgroup.

1 ¢.f. the ExpressionCorrelation plugin from Gary Bader's lab: http://baderlab.org/Software/ExpressionCorrelation
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Introductions and setup

Introductions

The three instructors that initiated this tutorial
are experienced Cytoscape developers, with a
cumulative of 15 years of participation in the
Cytoscape core team. All three have a strong
background in Cytoscape development, both from
the perspective of core development, but also from
the perspective of developing plugins that extend
Cytoscape functionality. They also have a long
history of working in the biomedical field, both
from the perspective of tool developers and the
underlying science.

Notes

&' Introductions

« John “Scooter” Morris
— 2010-Current

« Adjunct Assistant Professor, Pharmaceutical Chemistry
— 2004-Current

* Director, NCRR Resource for Biocomputing, Visualization, and
Informatics (RBVI) @ UCSF

— 1985-2004

+ Principal Systems Architect: Genentech, Inc.
— Cytoscape core team since 2006
— Author of several Cytoscape plugins

« SFLDLoader, structureViz, clusterMaker, chemViz,
metanodePlugin, groupTool, commandTool, bioCycPlugin

3

Introductions

¢ Alex Pico, Ph.D.
—2010-Current

« Executive Director, National Resource for Network
Biology

— 2007-Current

+ Bioinformatics Group Leader, Gladstone Institutes, UCSF
— Cytoscape core team since 2007
— Developer of several Cytoscape plugins:

* CriteriaMapper, GenMAPP Workspaces, GO-Elite,
GOLayout, BubbleRouter, Mosaic.

Introductions

* Allan Kuchinsky
— 1999-2013

« Principal Project Scientist, Agilent Laboratories, Agilent
Technologies

— 1996-1999
« Principal Project Scientist, HP Laboratories, Hewlett Packard
— 1984-1996
* Project Manager, Hewlett Packard
— Cytoscape core team since 2005
— Author of several Cytoscape plugins

« Agilent literature search plugin, HyperEdge Editor, Nature
Protocols Workflow plugin, GoLayout, BubbleRouter

— Lost his battle with cancer in 2013

6
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Setup

For the purposes of this tutorial, we will be using
Cytoscape 3.4. 3.x is the whole new version of
Cytoscape with modular architecture. It is
designed for long-term maintainability and
eventually it replaces 2.x series. New major
features, including new user interfaces, headless
(command-line) distribution, and multiple
rendering engine support, will be released for
this version. Cytoscape 3.4 is available as
installers for Mac, Windows, and Linux, which
include the core and sample files. Apps are
generally available for download with
Cytoscape’s App Manager or from the App Store at
http://apps.cytoscape.org/.

To avoid potential network problems or
contention, we have provided all of the plugins
that we will use for today on the CD that we’ve
distributed.

Notes

e -
P Installation
» USB flash drive
— Cytoscape 3.1.0 installers for Mac, Linux, Windows
— Several additional apps
— Sample data files
— PDFs for hands-on portions

&

Installation

* If you have not yet installed Cytoscape 3
— Choose the appropriate installer for your OS
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Biological Networks

In this section, we will begin to explore the use of
networks in biology. We begin by posing a
challenge: how do we make sense of biological
networks? We pose that challenge by providing a

series of pictorial examples of networks in biology.

The Challenge

The images on this slide are all representations of
biological networks. The challenge we are faced
with is to extract the “meaning” behind these
representations, which may be a purely visual
challenge, but it might also involve analytical
approaches.

All of the images at the right represent biological
networks, including the Excel spreadsheet.
Without more information about the content,
these images don'’t tell us much. How can we
extract this meaning? What are the analytical
techniques? What are the common visualization
approaches?

Notes

> The Challenge

+ Making sense out of biological networks....

&Y The Challenge

+ Making sense out of biological networks....

P - e

> The Challenge

+ Making sense out of biological networks....

15
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&’ The Challenge
If we simply think of a biological network as a list of

nodes and the edges that connect them, we’re not + Biological networks
going to be able to gain much information. However, — Seldom tell us anything by themselves
if we add information to those nodes and edges to ‘A"j"zs's '”;’0"’";15: i . )
. . .. s » Understanding the characteristics of the networ
that we can analyze the interactions (or similarities) _ Modularity
in more depth, or we use that additional information — Comparison with other networks (i.e., random networks)
. . . . — Visualization involves:
to visualize the nodes in some meaningful manner, Placi : ‘
. . ] . ) . « Placing nodes in a meaningful way (layouts)
we will find it easier to gain (or communicate) « Mapping biologically relevant data to the network
insight about aspects of the network. There are a ~ Node size, node color, edge weights, eto

. . . . « ...which then allowing for more analysis!
number of analytical and visualization approaches

that can help us, which are described below.

Taking the networks that we showed before, we can
begin to analyze or visualize additional data. In the image
at the right, we’ve colored the nodes in the network by
protein family membership (members of protein families
share functional characteristics), and then performed an
edge-weighted layout where the edge weights represent
the BLAST similarity between the proteins. As you can
see pretty quickly that similar proteins tend to group
together.

=

5@ QA0 8 8@ Ml

In this example, we’ve combined a network
representation with an analysis of some of the
associated data. The image at the left is a hierarchical
clustering of all of the genes in the TCGA glioblastoma
study vs. all of the patients in the study. This allows us
to look for patterns in the heat map and associate those
patterns with specific genes or groups of genes in the
pathway.

He R

ann
bEd AaQa 8 BE oms - B
Comrut = oo T combined scoe oot

CPE~E R v"":g%
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In the final example on the right, we have combined two
different visualizations with two different analyses. The
heat map on the left represents a hierarchical cluster of
genetic interactions and the network shows the results of
an MCL cluster of a set of physical interactions. These
views are linked, allowing users to select groups in one
view and determine if the same groups exist in the other
view. This allows researchers to explore areas where
there are tight protein-protein physical interactions as
well as genetic interactions, providing pretty strong
evidence for the existence of a complex.

But, how do we know what kinds of analyses make sense, and what kinds of visualizations are
appropriate?
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Biological Network Taxonomy

Before tackling this question, we need to understand that not all “biological networks” are the
same. In particular, there is a sort of taxonomy of networks - each visualization or analytical
technique can be either more or less appropriate for the different network types. For our
purposes, we can divide these biological networks into 3 main groups: pathways, interaction

networks, and similarity networks.

Pathways

The first type of network in our taxonomy is
probably the most familiar. We've all seen
pathway diagrams, whether those pathways
represent signaling pathways, metabolic pathways,
or regulatory pathways. These networks are often
hand-curated diagrams that have been
constructed for didactic purposes. However, even
though the positions and graphical annotations
associated with these networks does not lend
them to the normal types of network analysis
techniques, they can be extremely useful as
templates on which we can paint expression
profile information, or any other kinds of

» Pathways
— Signaling, Metabolic, Regulatory, etc m

annotation that we want to use to show information associated with the curated pathway.
Phylogenetic trees can also be thought of in a similar fashion of those trees have been hand
curated like the kinase phylogenetic tree [32] shown in the slide.

Notes
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Interactions

The second type of networks in our taxonomy are
interaction networks. While pathways are
probably familiar to most because of their use for
educational purposes, interaction networks are
what most people of when we think of “network
biology”. Basically, these networks reflect the
interactions between biological entities. The
entities might all be proteins, giving us the
canonical protein-protein interaction network
shown to the right in the first frame. The
interacting entities also be genes, in which case,
the network could be a genetic interaction
network. The middle panel at the right shows a
particular representation of an epistatic miniarray
profile (EMAP). These networks are formed by
recording the differential results of double-delete
mutants when compared to the expected
combination of single-delete mutants. The last
network shows a protein-ligand interaction
network. Interaction networks don’t necessarily
need to have only one interacting entity, and as we
are rediscovering the importance of metabolic
pathways, the “metabolome”, which combines
metabolites with the enzymes and regulatory
proteins which control metabolism. There are
also efforts underway to understand how the
interactomes of pathogens interact with the
interactomes of their hosts - yet another kind of
“mixed” interaction network.

Of course, there are many kinds of biological
interactions we might be interested in, up to and

including how people interact with each other. Such

social networks are beyond our scope, but social
network analysis is very similar to biological

Biological Network Taxonomy

Interactions
— Protein-Protein
— Protein-Ligand
— Domain-Domain
— Others
* Residue or atomic
* Cell-cell
» Epidemiology
« Social networks

networks analysis and provide a fruitful source of algorithms and visualization techniques.

Notes
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Similarity

The final type of networks we want to discuss are
similarity networks. In similarity networks, the

nodes represent biological entities and the edges
represent some measure of the similarity between
them. There are several types of similarity

networks that are commonly used in biology today.

One common similarity metric is the Tanimoto
coefficient[33-35], which represents the similarity
between two small molecules based on the

chemical fingerprints of each of them[36]. Other
similarity metrics include sequence similarity as
measured by BLAST[29, 37], PSI-BLAST[38], or
Smith-Waterman|[39], structural similarity as measured
by RMSD or other structural similarity measures[40-
45], or the ligand similarity as measure by the similarity
ensemble approach (SEA) method[28].

There are other types of non-biological networks that
use various kinds of similarity measures. Tag
clouds[46] and topic maps[47], which is one of the
semantic web technologies.

The images at the right show two examples of
similarity networks. The network on top is a protein-
protein similarity network showing the
Amidohydrolase enzyme superfamily from the
Structure-Function Linkage Database (SFLD)[48].
The colors on the network represent proteins of
similar function. Note that these proteins tend to
group together based on their BLAST similarity[29].

The network on the bottom shows a network of small-
molecules where the edges represent the Tanimoto

Biological Network Taxonomy

« Similarity
— Protein-Protein
— Chemical similarity
— Ligand similarity (SEA)
— Others

+ Tag clouds
» Topic maps

- *:,a ‘*‘

similarity between them. These networks can be useful to find molecules with similar structural

characteristics

Notes
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Analytical Approaches

The analysis of networks is a large and complex topic that we can’t do justice in a single tutorial
(even less a tutorial handout). In general, network analysis is part of the mathematics known as
graph theory, and there are entire conferences (and many textbooks) devoted to the area. A good
starting point might the Wikipedia article[49] or the online book “Graph Theory with
Applications”[50]. Our goal here is to provide a brief introduction and touch on some of the main

approaches used with biological networks.

Organization of complex networks

Complex networks have different levels of
organization. The illustrations on the right show how
to breakdown the hairball that arises when we
usually plot a large complex network. First, we can
look at single nodes and their local properties as the
node degree. These nodes are then linked to form
motifs, small subnetworks of three or more nodes.
Motifs are combined to form communities or modules
and communities are joined into the entire network.
The hierarchy of the network describes how the
various structural elements are combined.

There are some typical analysis tasks that are often
performed with biological networks.

* Network topology statistics are easy to compute
and to compare among different networks.
Among others they include node centrality,
betweenness, degree distribution of nodes,
clustering coefficient, shortest path between
nodes and robustness of the network to the
random removal of single nodes.

* Modularity refers to the identification of sub-
networks of interconnected nodes that might
represent molecules physically or functionally
linked that work coordinately to achieve a
specific function.

* Motif analysis is the identification of small
network patterns (or subgraphs) that are over-

(e .

< Analytical Approaches
The levels of organization of Local Structure
complex networks: N s

» Node degree provides
information about single nodes

» Three or more nodes represent
a motif

» Larger groups of nodes are
called modules or
communities

» Hierarchy describes how the
various structural elements are
combined

Global Structure

& Analytical Approaches

Network topology statistics Motif analysis is the
such as node degree, degree identification of small network

distribution, centralitiy, patterns that are over-
clustering coefficient, shortest  represented when compared
paths, and robustness of the with a randomized version of

network to the random removal the same network. Regulatory
of single nodes are important elements are often composed
network characteristics. of such motifs.

Modularity refers to the Network alignment and
identification of sub-networks of ~comparison tools can identify
interconnected nodes that might similarities between networks
represent molecules physically  and have been used to study
or funptionally Iinkgd thatwork  evolutionary relationships
coordinately to achieve a between protein networks of
specific function. organisms.

2

represented when compared with a randomized version of the same network. Discrete biological
processes such as regulatory elements are often composed of such motifs.

* Network alignment and comparison tools can identify similarities between networks (such as
common subgraphs) and have been used to study evolutionary relationships between protein

networks of organisms.
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Concepts
In mathematical terms, a biological network (any
network for that matter) is a graph, often written:

G = (V(G), E(G), o)
where V(G) are the set of vertices (nodes) in the
graph and E(G) are the set of edges. In this
particular notation, ¢ is the set of incidence
functions that define which edge goes with which
vertices.

The edges between nodes can either be directed
or undirected. This is easiest to understand

when considering the degree of a node. In an
undirected network, the degree of a node is

simply the number of edges connected to it. In
the first simple network at the right, the node
(node0) has three edges connected to it, so it has a
degree of 3. In a network with directed edges, we
need to expand our concept of degree to include in-
degree, the number of edges that connect to this
node, and out-degree, the number of edges that
originate from this node. In the second network at
the right, the size of the nodes reflects the node
degree.

There are also differences between the types of
networks. The first network at the right is a
multigraph. In a multigraph, there can be multiple
edges between nodes. The network at the far right
on the other hand, is a hypergraph. In a hypergraph,
an edge can be connected to more than two edges.

Notes

5% Analytical Approaches

» Concepts

— Graph/Network correspondence

— Node/Vertex correspondence

— Edge directedness

* Usually a network property

— Node degree
— Multigraph

« Allow multiple edges between nodes

— Hypergraph

+ Allow edges to connect more than 2 nodes
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Scale-free networks

One property of network topology that is of
interest is the degree distribution - that is, the
distribution of how many edges each node has
(also referred to as the connectivity
distribution)[51]. A network is said to be scale-
free if the degree distribution fits a power law. It
has been reported that many types of biological
networks are scale free[52-62]. The
characteristics of scale-free networks are that
there is a short path from any node to another
node (small world property), there are many nodes
with few connections and a few nodes

with many connections (hubs), and the

hubs are enriched with essential /legal

nodes (centrality and lethality 9
principal)[52, 63].

Scale-free networks have interesting
properties for biological systems - in

% Analytical Approaches

» Scale-free networks
— Degree distribution follows power law:
P(k) ~ kv, where y is a constant.
— Result is that there are distinctive
“hubs” (essential proteins?)
— Overall, though, network is resilient to
perturbation

— Biological (and social) networks tend to be
scale-free

@ O NetworkAnalyzer - Fitted Function - \

particular, they are robust to random

A power law of the form y = ax” was fitted.

breakdowns[64]. They are also (as the
name implies) invariant to changes in
scale. On the other hand, recent analysis
of several data sources have begun to
throw into question exactly how well

many biological networks fit the scale-free

a= 14846 b= -1.89 7
Correlation = 0.742
R-squared = 0.871

Note: R-squared is computed on logarithmized values.

(Cok ) (CHelp)

oK) (Help )

power law distribution[63, 65-67]. So, while none of the
authors have suggested that biological networks don’t
exhibit some scale-free characteristics, they don'’t fit the power-law degree distribution well

enough to be considered scale-free.

It should also be noted that biological networks aren’t the only network type that tends to be
scale-free. For example, both social networks and the Internet tend to be scale-free[68, 69]. In
both cases the overall topology tends to be one with a few hubs of high degree and lots of lower-

degree nodes.

Notes
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Small-world networks

One of the striking properties of many empirical P

i : i i 5 Analytical Approaches
networks is that despite their huge size, the average Ca y PP
path length is usually surprisingly small [70]. Such

* Small-world networks
networks are called small-world networks.

— any two arbitrary nodes are connected
by a small number of intermediate

Formally, a small-world network is defined to be a edges
network where the typical distance L between two — the network has an average shortest
randomly chosen nodes grows proportionally to the path length much smaller than the
. . number of nodes in the network
logarithm of the number of nodes N in the network: (Watts, Nature, 1998).
— Interaction networks have been shown
LxlogN to be small-world networks (Barabasi,

Nature Reviews in Genetics, 2004)
Many real-world systems have small-world -
properties when represented as networks. They
include the WWW, food chains, electric power grids,
metabolite processing networks, networks of brain Regular Small-world
neurons, telephone call graphs, and social influence
networks.

Interaction networks are also shown to be small-
world networks [51]. This could indicate that local
pertrubations such as regulation of the biological
activity of a given protein could reach the whole p=0 Increasing randomness p=1
network very quickly.

Notes
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Random networks _ ?; Analytical Approaches
Random networks (random graphs) are important ~

tools for determining the extent to which a + Random networks
Computationally derived network differs from a — Algorithms exist to create random networks
similar “random network”. This is, in principal, the * Flat random network Erdos-Renyi
« High clustering coefficient: Watts-Strogatz

same idea behind the BLAST expectation value or + Scale-free: Barabasi-Albert
the p value that you might get from a statistical test. ~ Nodes have similar degrees

— Useful to compare your network vs. a random
Networks, however, are complicated, and network

developing an appropriate probability model is non-

trivial. There are several algorithms commonly

used to generate random networks. In the simplest .

case, you can just generate a graph, G(n,p), where for

any two nodes N1 and N3, there is a probability p

that there is an edge between them[71]. This is similar to the Erd6s-Rényi model([72, 73] as cited
in [74]), but in the Erdds-Rényi model, the number of edges is restricted to a fixed number, M.
Thus, the graph, G(n,M), is a graph where all of the M edges appear with equal probability.

The problem with both of these “flat” models is that neither of the models are likely to result in
graphs that exhibit the characteristics of biological networks (small world, scale-free) discussed
above. One approach to this is to explicitly model the random graph such that it exhibits small-
world properties (short average path lengths and high clustering). The is the approach proposed
by Watts and Strogatz[70]. In the Watts and Strogatz model, there are three key parameters: the
number of nodes, N, the mean degree of the nodes, K, and a tuning parameter f, which is between
0 and 1. The algorithms begins by generating a network with N nodes, each connected to K
neighbors, K/2 on each side. Then for every edge (n;n;) rewire that edge with probability § such
that there are no loops and there is no duplicate edges. The result depends on the value of . If

is near zero, the result is a regular lattice. If § is one, this approaches the random graph similar to
the Erd6s-Rényi model with p = NK
2(%) Scale-free
Another approach is to implement a random graph that
is scale-free. The Barabasi-Albert model is an approach
to generating random scale-free graphs[68]. This
approach starts with a small network G(n,m), where n is
the number of nodes (22) and m is the number of edges.
The requirement is that all nodes have degree of at least

1. Then new nodes are added according to a probability g
pi:

)
log P(k)

ok v
pl_Ejk-f k log k

where ki is the degree of the node i. This results in hubs

(nodes with more edges) continuing to get more edges

and nodes with fewer edges being less likely to get new edges. This results in a degree
distribution that fits the scale-free model quite well, but is still random in nature.
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Network measures

We've mentioned the three most common “t: Analytical Approaches

network measures already: node degree, path
length, and clustering coefficient. The first two of

* Network measures
— Node degree

these are intuitively understandable. The third is * Node indegree: # of edges for which this node is a target
. - e - . . » Node outdegree: # of edges for which this node is a
a little more difficult to conceptualize since it source
doesn’t fit our concept of clusters (i.e. groupings of — Shortest path length
B + Shortest traversal distance between two nodes
nodes or modularlty) very well. + Can be weighted if edges have weights or hops if not
— Clustering coefficient
Node degree is, as we've already mentioned, the ol ComNorted arogpy TS Of & ode are to being
number of edges connected to this node. In a « # of edges connecting a node’s neighbors/the node’s

degree

directed network, the node indegree is the number

of edges directed towards this node, and the node
outdegree is the number of edges directed away

from this node. In the network at the right, for
example, node3 has an indegree of 2 and an outdegree
of 1 (assuming we count the undirected edge as both
in and out).

Path length is also relatively easy to imagine. If we
look for the shortest path from nodeO to node3 (the
first network at the right) it’s the edge between them.
On the other hand, the shortest path from node3 to
node0 goes through node2 (because the edge
between node0 and node3 is directed). The length of the path
is often just a hop count (1 in the first example, 2 in the second),
but can also be weighted, which might mean the shortest path is
not the path that traverses the fewest nodes.

The clustering coefficient is a measure of the degree to which
nodes form a complete graph. It was originally defined to
measure the degree to which a network exhibits small-world
properties[70]. For undirected graphs, the local clustering
coefficient is given as the number of edges between neighbors of

2‘{€jk}‘

node i divided by the maximum possible number of edges: Ci = k(i — 1)

In the network example at the right (assuming it’s undirected), node3 has two neighbors (degree
2),node2 and node0 share an edge, so we have (2*1)/2(2-1) = 1. On the other hand, node0 is
degree 3, but only node2 and node3 are connected, so we have (2*1)/3(3-1) =.3. The network
average clustering coefficient can be used to express the degree to which a graph exhibits small-

— 1w
world properties. The average is simply: C = — Qi
n <=
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Another important set of networks measures that
has important properties are the various
centrality measures. These approaches (in
general) attempt to provide a measure of the
importance of a given node. There are many
centrality measures, but we’ll just discuss three of
them here.

The first centrality measure we’ll discuss is degree
centrality. Nodes with high degree centrality are
the hubs in scale-free networks, for example. This
is an easy measure to compute the degree

centrality (Cp) of node v: Co(v) = %, where n is

the number of nodes in the network.

Betweenness centrality is another centrality
measure than tends to reflect the essentiality of a
node in the network. Essentially it measures the
extent to which “all roads lead through” this node.
The betweenness centrality for a node v is

calculated as: Cs(v) = E @ where oy is the

s=v=tEV  Ost
number of shortest paths from s to t and o (v) is
the number of shortest paths from s to t that go
through v. Betweenness is usually normalized by

dividing with the number of node pairs. Intuitively,

2328
3

& Analytical Approaches

» Centrality - measures of node importance
— Degree centrality (find hubs)
+ Degree of this node / (# of nodes — 1)
— Betweenness centrality (essentiality)

» The average number of shortest paths that go
through this node

— Closeness centrality

» The sum of all shortest paths between this node and
all other nodes / (# of nodes — 1)

5
2

Clusterin gCoefficient Degree
Lo 0.66666667 Lo 0.33333333
0.0

333
2a2aga
LRES

0.0 X
133333333 0.66666667 0.75 0.5
2.0 0.0 0.5 1.0

this makes sense - if a large percentage of the shortest paths between two nodes go through a
given node, removal of that node will have a significant effect on the network topology (from the

perspective of those two nodes).

Closeness centrality is the degree to which this node is close to all other nodes. It is again

calculated based on shortest paths: Cc(v) =

Stevey SO0
n-1 4

where S(v,t) is the shortest path between v

and t. So, in a star topology, where all nodes are connected to a single hub, the closeness centrality
measure for the hub is 1 and ~2 for all other nodes?. This value is usually reported as the inverse,

1/Cc(v).

Notes

2 It's approximately 2 because the shortest path between a non-hub node and all of the other nodes is 2

except for the hub node, in which case the shortest path is 1.
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Clustering r; | Analytical Approaches

Clustering is a heavily used technique for - Clustering (find hubs, complexes)

analyzing networks, both biological and otherwise. — Goal: group related items together
The overall goal of clustering is to group items + Clustering types:
together that are related based on some measure. — Hierarchical clustering

+ Divide network into pair-wise hierarchy

Clustering is an active area of research and there — K-Means clustering
are many clustering algorithms that have long * Divide network into k groups
been used for biological applications, and even —McL o
i . + Uses a flow simulation to find groups
more algorithms that are being developed for — Community Clustering
Specialized purposes. » Maximize intra-cluster edges vs. inter-cluster edges

26

Before we talk about specific clustering

approaches, it is important to understand that all

of the clustering approaches depend on some

metric for determining the similarity of the items being clustered. This similarity metric is
termed a distance metric in clustering terms, and there are a number of ways to calculate the
distance in feature space (that is, the terms or values you are using to determine the similarity
between objects). A common measure is the Euclidean distance, which is simply the distance
between two points in n-dimensional space:

d(p,q) = \/(Ql - pl)2 + (qz - p2)2 + ..+ (qn - pn)2

Other common techniques are based on the Pearson correlation, r, between any two series of
numbers x = (xy, Xz, ..., Xn) and y = (y1, Y2, ..., yn), Which is defined as:

o

where Oy is the standard deviation of the x series, and Oy is the standard deviation of the y series.

This term can be either centered (as above), or uncentered, which assumes a mean of zero (even if
it's not). There are many other approaches to calculating the distance, from taking the negative
log of the BLAST e-value to much more complicated approaches designed to account for specific
characteristics of the data.

Hierarchical Clustering

A very common clustering approach is hierarchical clustering[75]. As the name implies, this
approach divides the objects into a pairwise hierarchy. Hierarchical clustering has been used for
many years as one of the major approaches to analyzing and visualizing microarray data[76]. An
important first step in performing hierarchical clustering is to determine the distance metric
(above). The second step is to determine how to link the pairwise distances3:

* Single linkage clustering takes the minimum pairwise distance,
*  Complete linkage clustering takes the maximum pairwise distance,

3 This list is taken from the clustering approaches used in the original Cluster program from Eisen
and colleagues, which has been inherited by clusterMaker and other Cluster-clones.
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*  Average linkage clustering (UPGMA) takes the average of all of the pairwise distances,

* Centroid linkage clustering takes the distance between the centroids of all pairs of elements.
Once the metrics and linkages have been selected, clustering may be accomplished by either an
agglomerative (bottom-up) or divisive (top-down) method. In either case, the result is tree
(hierarchy) where the nodes closer together in the tree are more similar. For microarray data,
this is often shown as a dendrogram associated with the heatmap that reflects the fold changes in
the expression data (see the example below).

k-Means Clustering

Another common clustering technique is k-means[77, 78]. In k-means clustering the algorithm
divides the data set up into k groups in such a way that the value of the item gets assigned to the
cluster with the nearest mean. The approach is relatively simple: given a set of n data items the

idea is to partition the n items into k sets so as to minimize the within-cluster sum of squares
(WCSS):

.k
R

i=1 xjESi

where S = (S1, Sz, ..., Sn) are the clusters and u; are the mean of the points in each cluster S;. k-
means has been used in a number of applications, and has been incorporated in to a number of
other algorithms.

There are many other clustering algorithms and combinations of algorithms used in network
applications - far too many for us to cover here. Often these algorithms are general algorithms
(e.g. Community clustering[79], MCL[31, 80, 81], Spectral Clustering[82-86], and Affinity
Propagation[87, 88]) and often they designed for special purposes (e.g. SCPS[89], MCODE[5],
FORCE[90], TransClust[91]). Some algorithms are actually combinations of algorithms (e.g.
AutoSOME[92]). We're going to cover only three of these algorithms (MCL, Spectral, and Affinity
Propagation), but the interested reader is encouraged to explore the references below.

MCL Clustering
MCL clustering (MCL is short for Markov Clustering) is a clustering approach that simulates a
weighted random walk through a network. The idea behind the algorithm is that because edges
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within the natural groupings will most likely stay within the group, the vast majority of the steps
in a random walk will be within the natural group. The other way to think about it is by imagining
edges as flows - most of the flow through a network with natural clusters will stay within the
clusters - very little will flow between the clusters. The simulation of the random walk is by
alternate application of two operations: expansion and inflation. First, the distance matrix is
converted to a stochastic matrix (a non-negative matrix where each of the columns sums to 1). In
the expansion step, the stochastic matrix is squared using the normal matrix product. In the
inflation step, the Hadamard product of the matrix (entry-wise multiplication by an inflation
parameter, I) is taken. After the inflation step, a scaling step is added which returns the matrix to
a stochastic matrix. Repeated expansion and inflation will have the result of removing cells in the
distance matrix (i.e. edges) that represent inter-cluster edges.

MCL clustering has been used for a large number of biological applications, including the finding of
protein complexes in protein-protein interaction networks and the grouping of proteins in protein
similarity networks. MCL has proven to be very fast and robust with then number of edges is
reasonably low, but can have problems resolving dense networks necessitating some form of
algorithm or user-chosen cut-off value to reduce the edge density[93]. MCL has the nice
characteristic that it does not necessitate the user to select the number of clusters in advance,
although the inflation parameter I does have to be specified.

Spectral Clustering

Spectral clustering takes in name from the use of spectral properties of the similarity (or distance)
matrix constructed from the network. Given a set of data points A, the similarity matrix may be
defined as a matrix S where S;; represents a measure of the similarity between points i and j which
are members of the set A. Spectral clustering techniques make use of the spectrum of this matrix
of the data to perform dimensionality reduction for clustering in fewer dimensions.

One such technique is the Normalized Cuts algorithm[94, 95], commonly used for image
segmentation. It partitions points into two sets (51,52) based on the eigenvector v corresponding to
the second-smallest eigenvalue of the Laplacian matrix

L=I-DSD"

of S, where D is the diagonal matrix
Djj = E Sij
j

This partitioning may be done in various ways, such as by taking the median m of the components in v,
and placing all points whose component in v is greater than m in S;, and the rest in S,. The algorithm can
be used for hierarchical clustering by repeatedly partitioning the subsets in this fashion.

A related algorithm is the Meila-Shi algorithm[82], which takes the eigenvectors corresponding to the k&

largest eigenvalues of the matrix P = SD™' for some , and then invokes another (e.g. k-means) to cluster
points by their respective k components in these eigenvectors.
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Spectral clustering techniques are very useful in biology, but they have the disadvantage that since they
essentially divide the data into two sets, you must either combine them with something like k-means or
use a hierarchical decomposition to arrive at a more refined clustering.

Affinity Propagation

Affinity propagation[87] is a newer algorithm that takes a message passing approach rather than a
mathematical approach to clustering. Basically, as with the other approaches, affinity propagation
takes a similarity matrix s(ij), which represents the starting point of the algorithm. In addition,
each point is given a preference value s(k k) which is used to seed the likelihood of this point being
an exemplar for the formation of a cluster (this is often just set to a flat value to allow the
algorithm to learn the number of clusters). Then, the points exchange messages of two types:
responsibilities (r(;k)) are sent from point i to point k and reflects the degree to which k is a good
exemplar for point i; and availability (a(i,k)) is sent from point k to point i to reflect the evidence
for i to choose k for its exemplar. The algorithm runs until some stopping point usually based on
the degree to which r(i k) and a(i,k) change during each pass. See their web site (http://
www.psi.toronto.edu/index.php?q=affinity propagation) for more information about the
algorithm and its application.

Affinity propagation has numerous applications in biology and seems to perform well in the
datasets provided by the authors. Some comparative analysis by others[96] suggests that other
algorithms might be less susceptible to noise and more robust for some applications.

Notes
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Guilt by association

Another technique for finding the function of
unknown genes is “guilt by association”. The
basic idea is simple - if a particular gene or
protein is “associated” with one or more other
genes or proteins of a particular function, then
that gene or protein likely shares that function.
A common example is to look at the expression
profile of a gene and then match it to a number
of genes that are similarly expressed. If all of the
genes that are similarly expressed perform a
similar function, then this gene probably
performs that same function[97].

Another use of “guilt by association” is to find
disease-related proteins. The idea is
the same as above - given a gene or
protein search for related genes or
proteins that are associated with
diseases[98]. If they are related
closely to the gene of interest, then we
might assume that it is also associated
with the disease. The pictures at the
right show the result of querying
GeneMANIA[99-101] with BRCA1,
which is known to be associated with
breast cancer. The resulting network
includes many other breast cancer
associated genes, including BRCA2 ‘3
and PALB2.

Notes

%: : Analytical Approaches

Guilt by association
— Combine weak signals to get a stronger one.

— Two main applications:

« Suggest network or functional relationship based on
related data (e.g. co-expression).

« Infer function or role (i.e. in disease) based on
related data
— Some algorithmic approaches
+ Random walk with restarts
« Semi-supervised learning
« Belief Propagation
— Example: GeneMAN!qA
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Network motifs

A network motif is a pattern of connectivity
that occurs more frequently than might be
expected by a random connection of
nodes[102]. As might be expected by the
reuse we often see in biology, biological
networks tend to have a small set of
network motifs that act like components in
a larger circuit[103, 104]. Network motifs
have been identified in the gene regulation
network of E. coli[105] as well as a larger
set of networks[106]. There are a number
of network motifs that have been identified
in biology, including feed forward
loops[107-111] (like the one shown at the

oY Analytical Approaches

* Motif finding

— Search directed networks for network motifs
(feed-forward loops, feedback loops, etc.)
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An enhanced Cytoscape network
querying app
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right), feedback loops[112-114], positive and negative auto-regulation loops[115]. These
biological circuits are critical to regulatory processes in the cell, so identifying them in protein-
protein interaction networks can provide important clues to the pathway which the protein

participate in[116-118].

Notes
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Overrepresentatllon analy5|§ . Sy Analytical Approaches
Overrepresentation analysis (ORA) is an

important tool used to identify aspects or + Overrepresentation analysis
attributes of a subset of nodes that are - Find terms (GO) that are statistically

overrepresented in a network
— Not really a network analysis technique
— Very useful for visualization

statistically more common in those nodes than in
the full set. The most common approach is to
cluster a group of genes based on expression

data and look for overrepresentation of

various gene ontology (GO)[119] terms —
in the groups to determine if a
particular expression pattern suggests a
particular biological process[120-123].

One of the things to keep in mind when
doing ORA is that the resultant p-values
may need to be adjusted since multiple
tests are conducted. This makes sense -
if we're performing multiple tests we
increase the possibility that we'll get a false positive based on random chance. Two methods for
correcting for multiple tests are the Dunn-Bonferroni Familywise Error Rate (FWER)[124]
correction and the Benjamini & Hochberg False Discovery Rate (FDR)[125] correction.

The image at the right shows the results of an overrepresentation analysis of a yeast expression
data set using the Cytoscape BiNGO plugin[126].

Notes
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Visualization

In the previous sections, we made use of a number of visualization techniques that are easily taken
for granted. In this section, we will detail the techniques and key decisions involved in producing
network and pathway visualizations. Using biological networks to visualize data is a critical aspect
of exploratory analysis: facilitating interpretation, new insights and new hypotheses (PMID:
20824171). We are visual creatures, after all.

Depiction ano — \
The basic visual motif of networks in Cytoscape is that of nodes and
edges. In biological networks, the nodes often represent genes, @Q\%ﬂ\

. . . @ >
proteins or small molecules, while the edges (or lines) represent — B
interactions and relationships between connected nodes (see figure at | MOM2 —(ps 3
the right). Beyond this core motif, all other visual features (e.g., shape,
size, color, thickness, label, transparency, etc) are flexible and can be

used to represent practically any data value, annotation or attribute.

Data Mapping

The first thing most users want to do in Cytoscape is to map their data
onto networks for visualization. The variety of data and

network types has already been explored in previous

sections. Here, we will focus on the mechanics of data BN Data Mapping
mapping using the VizMapper interface.

Node and edge motif in
various visual styles

» Mapping of data values associated with
graph elements onto graph visuals

VizMapper provides a user interface for controlling the « Visual attributes

mapping of data attributes to visual attributes. There is — Node fill color, border color, border width, size,
a long list of available visual attributes that can be :‘fpe' opaciy, label . ‘
. . . . — Edge type, color, width, ending type, ending
mapped to, including node properties such as fill color, size, ending color
border color, shape, width, height, opacity and label, ’ '\fi‘:‘:'srt‘frxgﬁzabels)
and edge properties such as type, color, thickness, as — Continuous (numeric values)
well as arrow type, size and color. — Discrete (categories)
Notes
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Data attributes can be mapped in three main ways: Passthrough - directly passing the data value
to the visual attribute, e.g., labels. Continuous - mapping a continuous range of numerical values
to a range of visual attributes, e.g., expression values to a color gradient. Discrete - mapping
discrete data values (string or numeric) to specified visual attributes, e.g., five different categories

to five different colors.

The next two examples focus on two types of
Continuous data mapping, since these are the most
useful and most challenging. First, we map degree-of-
connectivity (the data attribute) to node size (the visual
attribute), so that more connected nodes appear
proportionally larger, thus highlighting potential “hubs.”
In the VizMapper interface, you would begin by double-
clicking on ‘Node Size’ and selecting the data attribute
containing degree information. Then select “Continuous
Mapping” type and click the graphic to edit the mapping
parameters. The min and max of the data attribute is
given as the x-axis and the visual attribute is the y-axis.

The second example maps continuous expression
values to node color. Once again in the VizMapper
interface, you would double-click the visual attribute,
pull-down the data attribute and then choose
“Continuous Mapping.” When you click on the graphic,
you will notice a different parameterization. Once again,
the data attribute is given as the x-axis, but now instead
of a y-axis, you will find thresholds that control the ends
and mid-point of a color gradient as well as step-
function thresholds to set discrete colors for values
exceeding the gradient range. This is a handle tool for
focusing the continuous mapping of color to a critical
range of data.

Notes

N Data Mapping
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Layouts

The majority of network information does not come with
fixed coordinates. With the exception of manually
curated pathway diagrams, networks typically rely on

automated layout algorithms to position nodes and edges.

Cytoscape comes with a wide variety of built-in layout
algorithms that can be applied to any pathway or
network. In addition, a number of plugin extensions have
been developed to support additional layouts.

Here, we will describe the main layout types natively
supported by Cytoscape. You can find these in the menu
Layout > Cytoscape Layouts.

Grid Layout - a simple layout of nodes in arbitrary
order arranged in a grid pattern. This layout does not
take in account edge crossings, weights or degree of
connectivity.

Group Attributes Layout - performs a grid layout but
orders nodes according to a user-selected attribute, e.g.,
ascending order based on a numerical attribute.

Hierarchical - based on connectivity, this layout
defines ordered layers of nodes in a tree structure, e.g.,
phylogenetic trees.

+ Layouts determine the location of nodes and
(sometimes) the paths of edges
» Types:
— Simple
* Grid
« Partitions
— Hierarchical
« layout data as a tree or hierarchy
« Works best when there are no loops
— Circular (Radial)
« arrange nodes around a circle

« could use node attributes to govern position
— e.g. degree sorted
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Circular Layout - arranges nodes around the circumference of a circle. The order of the nodes is
arbitrary in the basic version. There two other versions: Attribute Circle Layout, which orders
nodes based on a user-selected attribute, and Degree Sorted Circle Layout, which orders nodes
based on their number of connections. Pro-tip: The Degree Sorted Circle Layout calculates the
degree for each node and creates a new attribute that can be used for other purposes as well, e.g.,

data mapping.

Notes
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Force-Directed Layout - simulates edges as springs,
resulting in clusters of highly connected nodes with

minimally connected nodes spaced and in the periphery.

You can also choose to influence the layout based on an
edge attribute, if available. A related layout is Spring
Embedded, which also simulates edges as springs. Both
of these layouts also have explicit Edge-Weighted-
versions that provide more control.

Furthermore, you can apply layouts to selected subsets
of nodes. If you make a node selection prior to browsing
the Layout menu, you will see an additional submenu
option to apply the layout to “All nodes” or “Selected
Nodes Only.” By using this feature, you can effectively
combine different layouts for a single network. For
example, after applying a Force-Directed Layout, you
could then select a connected subset and apply a
Hierarchical Layout just to that set.

To achieve just the right visual layout for your network,
you may need to “tune” a layout algorithm. You can do
this by going to Layout > Settings... and then select the
layout algorithm you want to tune. The settings expose
the parameters of each algorithm so that you can
explore different layout behaviours.

Notes

BN

» Types:
— Force-Directed
« simulate edges as springs
* may be weighted or unweighted
— Combining layouts
« Use a general layout (force directed) for the entire

graph, but use hierarchical or radial to focus on a
particular portion

— Multi-layer layouts
« Partition graph, layout each partition then layout
partitions

— Many, many others

BN

» Use layouts to convey the relationships
between the nodes

« Layout algorithms may need to be “tuned”
to fit your network
— Layouts>Settings... menu

* Lots of parameters to change layout
algorithm behavior

+ Can also consider laying out portions of
your network
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Animation

There are cases where a static image doesn’t tell the
whole story. Perhaps you have collected data in a time
series or have more than one condition you want to
compare. Animation is a key technique for visualizing
change.

There are a handful of plugins for Cytoscape that
support automatic, step-wise animation through
defined VizMapper styles (e.g., clusterMaker and
VistaClara). But there is also a dedicated plugin called

CyAnimator that supports flexible animation creation.

Using CyAnimator, you choose the frames of the
animation as you work. Interpolation fills-in the
transitions between frames for a wide range of visual
features, including position, size, color, and opacity. A
final set of images are generated and ready to be

imported into a number of free or commercial movie file

generators.

Notes

oy
Ta

» Animation is useful to show changes in a
network:

— Over a time series
— Over different conditions
— Between species
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Introduction to Cytoscape

Cytoscape is an open source bioinformatics software
platform for visualizing molecular interaction

networks and biological pathways and integrating
these networks with annotations, gene expression
profiles and other state data. Although Cytoscape was
originally designed for biological research, now itis a
general platform for complex network analysis and
visualization. Cytoscape core distribution provides a
basic set of features for data integration and
visualization. Additional features are available as
plugins (now called Apps). Plugins are available for
network and molecular profiling analyses, new layouts,
additional file format support, scripting, and connection
with databases. Plugins may be developed by anyone
using the Cytoscape open API based on Java™ technology
and plugin community development is encouraged. Most
of the plugins are freely available.

Cytoscape is a collaborative project between the
Institute for Systems Biology (Leroy Hood lab), the
University of California San Diego (Trey Ideker lab),
Memorial Sloan-Kettering Cancer Center (Chris Sander
lab), the Institut Pasteur (Benno Schwikowski lab),
Agilent Technologies (Annette Adler team), the
University of Toronto (Gary Bader Lab), Gladstone
Institutes (Bruce Conklin and Alex Pico), and the
University of California, San Francisco (Tom Ferrin lab).

Notes

N Introduction to Cytoscape

» Overview
» Core Concepts
— Networks and Tables
— Visual Properties
— Cytoscape Apps
» Working with Data
— Loading networks from files and online databases
— Loading data tables from CSV or Excel files
— The Table Panel

» Cytoscape tips & tricks

5 Cytoscape
= — cytoscape.org
- Visualization

& - Integration
- Analysis
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Core Concepts

Cytoscape creates networks, where nodes of the
network represent objects (such as proteins) and
connecting edges represent relationships between
them (such as physical interactions). Each Edge
connects two Nodes. Edges can be directed or
undirected. In the case of a directed edge, there is a
Source and a Target Node. Once this basic network is
created, various attributes of the nodes and edges
(such as protein expression levels or strength of
interaction) can be added to the network and
incorporated as visual cues like shape or color.

Notes

¢ Core Concepts

* Networks and Tables

Networks Tables
e.g., PPIs or pathways e.g., data or annotations
P
\J
< Core Concepts

* Networks and Tables

Networks NGZ Tables
Visual Styles

51
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Visual Styles

One of Cytoscape's strengths in network visualization is the ability to allow users to encode any
attribute of their data (name, type, degree, weight, expression data, etc.) as a visual property (such
as color, size, transparency, or font type). A set of these encoded or mapped attributes is called a
Visual Style and can be created or edited using the Cytoscape VizMapper. With the VizMapper,
the visual appearance of your network is easily customized. For example, you can:

Use specific line types to indicate
different types of interactions.

Set node sizes based on the degree of
connectivity of the nodes.

Browse extremely dense networks
by controlling for the opacity of
nodes.

Set node font sizes based on the degree of
connectivity of the nodes.

Visualize Gene Expression data its biological context by
superimposing colors onto the nodes based upon their Gene
Expression data values.
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Apps

Cytoscape allows users to extend its functionality
by creating or downloading additional software
modules known as “Apps”. These extensions
provide additional functionality in areas such as
network data query and download services;
network data integration and filtering; attribute-
directed network layout; GO enrichment analysis7;
as well as identification of network motifs,
functional modules, protein complexes, or domain
interactions.

Links to these apps can be found at
http://apps.cytoscape.org

Altogether, Cytoscape and its Apps provide a
powerful tool kit designed to help researchers
answer specific biological questions using large
amounts of cellular network and molecular
profiling information.

Notes

Wall of Apps
‘.,.;..;... P ‘“"“‘ﬁ ‘:a[ = ‘:_ . . & w
R B VOES @ r Q<

@ . .I'IAIN: @ ML nbic :E: = g
S . l B e HB
WO Yer GHE. -TO

& JML i ey |

Q $ . ) nbic S G P e
g @ o ;& oy X & ";t <
& o if/"j@: B+ nbic | :5: ] @
P
\4
< Cytoscape
+ Common use cases
— Visualizing:
« Protein-protein interactions
« Pathways
— Integrating:

« Expression profiles
« Other state data

— Analyzing:
* Network properties
« Data mapped onto network

43
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BiNGO

BiNGO is a Java-based tool to determine which & Cytoscape: Platform
Gene Ontology (GO) categories are statistically
overrepresented in a set of genes or a subgraph * Cytoscape as a platform
of a biological network. BiNGO is implemented — App architecture
as a plugln fOI' Cytoscape. « http://apps.cytoscape.org
— Use cases

» Expression data analysis
BiNGO maps the predominant functional themes  Protein complexes
of a given gene set on the GO hierarchy, and * Agilent literature search
outputs this mapping as a Cytoscape graph. Gene
sets can either be selected or computed from a
Cytoscape network (as subgraphs) or compiled
from sources other than Cytoscape (e.g. a list of ”
genes that are significantly upregulated in a
microarray experiment).
The main advantage of BINGO over e e ORI o]

500

other GO tools is the fact that it can be
used directly and interactively on
molecular interaction graphs. Another
plus is that BiNGO takes full advantage
of Cytoscape's versatile visualization
environment. This allows you to
produce customized high-quality
figures.

BiNGO features include:

* Assessing overrepresentation or
underrepresentation of GO
categories
* Graph or gene list input
* Batch mode: analyze several clusters simultaneously using same settings
* Different GO and GOSlim ontologies
* Wide range of organisms
* Evidence code filtering
* Hypergeometric or binomial test for overrepresentation
¢ Multiple testing correction using Bonferroni (FWER) or Benjamini&Hochberg (FDR) correction
* Interactive visualization of results mapped on the GO hierarchy.
* Extensive results in tab-delimited text file format
* Ability to make and use custom annotations, ontologies and reference sets
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Agilent Literature Search

Agilent Literature Search Software is a meta-search tool for automatically querying multiple text-

based search engines (both public and proprietary) in
order to aid biologists faced with the daunting task of

manually searching and extracting associations among

genes/proteins of interest.

Agilent Literature Search Software can be used in
conjunction with Cytoscape, which provides a means
of generating an overview network view of
gene/protein associations.

Agilent Literature Search software provides an easy-
to-use interface to its powerful querying capabilities.
When a query is entered, it is submitted to multiple
user-selected search engines, and the retrieved
results (documents) are fetched from their
respective sources. Each document is then parsed
into sentences and analyzed for protein-protein
associations. Agilent Literature Search Software
uses a set of "context" files (lexicons) for defining
protein names (and aliases) and association terms
(verbs) of interest. Associations extracted from
these documents are collected into a Cytoscape
network. The sentences and source hyperlinks for
each association are further stored as attributes of
the corresponding Cytoscape edges.

Agilent Literature Search Plugin Features:

Agilent Literature Search 3.0.3 beta (LitSearch version 2.68)

X u >

Query Matches

thway in Human Lung.
i Zhang X Iniesx

« Meta-search engine combining Information Retrieval & Knowledge Extraction

« PubMed, OMIM, USPTO

« Load/Save/Reanalyze search results

« Paged Search results view

« User context-based aliasing

« File-based lexicon management

« Symbol identification, interaction extraction
« Cytoscape session load/save compatible

« Putative network generation from literature

« Literature-based evidence gathering for Cytoscape Edges
« Extend a Cytoscape network with associations extracted from the literature
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Loading Networks
There are 4 different ways of creating networks in

Cytoscape:

1. Importing networks from Public Databases

2. Importing pre-existing, unformatted text or Excel
files.

3. Importing pre-existing, formatted network files..

4. Creating an empty network and manually adding

nodes and edges.

& Crtoscape [N (65 View Seiect_Layout_Apps_Tools _help
800, RecemSesson

B O W SwESIAM L Scooer]

MO “

BN »

Loading Networks from a Web Service
In this section we will look at how to import networks
using publicly accessible databases.

First, select the File> Import-> Network from Public
Databases menu item. By default, Cytoscape only provides one
public database item (Interaction Database Universal Client),
but there are several others available as apps.

Step 1: Search. Type in a search term or set of search terms
separated by newlines. In this example we use the Interaction

Database Universal Client, and enter TRAF1 as our search term.

Step 2: Select. Select Reactome-FIs as our database
source and select Import. This will import the
interactions provided by Reactome into a Cytoscape
network. When the network has successfully loaded, you
will see it displayed in the top center panel (Network
View). There will also be a ‘birds eye’ overview in
bottom-left panel that shows the entire network.

k from Web Service

@ @ W QQAQ W teow i

Search Mode: |_Search by ID (gene/protein/ compound ID)

2. Select Database

Clear Select All | & Merge results into one network

Session: New Session
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Now let’s extend our network by merging in the known
protein-protein interactions for TRAF2. Follow the same
procedure as above but this time select TRAF2 in Step 1 to
search and import the interactions from Reactome.

This will bring up the protein-protein interaction
network for TRAF2. The image to the right shows the
two star networks: one for TRAF1 and one for TRAF2.
We can use Cytoscape’s internal tools to merge them.

Under the Cytoscape Tools menu, select Merge Networks.
Select both networks (TRAF1 and TRAF2) that you want to
merge and click “Merge”.

Service

Search Mode:|_Search by ID (gene/protein/compound ID) i | search | | Refresh

2. Select Database
........ Outabuse Name  Records Found +
Index

Clear Select Al | ¥ Merge resuits into one network Close

800

W QQAQ W g TR o

e Network 2013/10/1...

x

‘‘‘‘‘

Table Panel Hx

[ 5 B O M fw [ Merged Network 2013/10/13 421:44 AM, CEST)

shared..|  mame |
Qe quen
B sewr
PEIOSE 761088

942

Z| o Prefuse Force Directed Layout

The combined TRAF1/TRAF2 protein-protein
interaction network will be displayed (the image at
right shows TRAF1 and TRAF2 selected for clarity).

n ey 08 @
[-XeX¢) Advanced Network S— —
Operati
Networks to merge
Avalible networks Seeced nevwarks
-y | Mersea nevork @o13/10/13 42
Merged Netark (2013/10/13 4.2
Advanced Newwork Merge »
P
800 Session. New Session. o
B E S Y N E QQAAQA W By v °
Conerol Panel ax 800
ORI Stvie  Fiter | Fier ONew | Sets

Nodes  oges
5000 49(0)

o 13200

4@ 1500)

Table Panel X
JE 8 ORM s (S
hared| mame | x| Machi.| Wumn.| waona.| wiosa.| wow

BTSN coge Tabie  Newwork Tabie

%] o Prefuse Force Directed Layout et o£632Co oo omsed emory | (e K@)
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Load a Network from a Table

In this section we will explore how to create
Cytoscape network by importing a pre-existing
text or Excel file. The figure at right shows one
such example network, consisting of four nodes
and four edges.

Let’s begin creating the network by selecting the

File-> Import-> Network - File... menu item.

In this example, we will import the file
galFiltered.csv.

Notes

Loading Networks

» Use import network from file

— Excel file

— Comma or tab delimited text

& Cytoscape [GTN 6ot View Select Layout Apps Toois Help
YT

:::::::::

- —
M KX
xs x

rch metwork.
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An interactive graphical user interface allows you to

specify parsing options for specified files. The screen

provides a preview that shows how the file will be
interpreted given the current configuration. As the
configuration changes, the preview updates
automatically. In addition to specifying how the file

will be interpreted, you also choose the columns that

represent the source nodes (®), the target nodes (@),

an optional edge interaction type (»), source attribute

(), target attribute (2), or edge attribute (2). To
change the default selection chosen by Cytoscape,

click on the arrow in the column heading. The dialog

will also allow you to change the column type.

Under the Advanced Options section, you will see a set of checkboxes appear. These allow you to

choose the:

* Delimiter. The delimiter character that separates

columns (fields) in the import file. This can be a
tab, comma, semicolon, space, or any arbitrary
delimiter character that you define.

* Default Interaction: You can set the name of the

Default Interaction type, which is used to name an

edge. The example in our figure uses ‘interacts

with’ (for protein-protein interaction) as its default

interaction.
e Column Names. You can choose whether to use

the first line of the file to supply column names, one

name per delimited column in the file.
e Startimportrow. You can set the importline

number so that you can skip over any initial header

or comment lines in the file.

Import - Advanced Options

File Import Options

Delimiter:

Default Interaction:

Start Import Row:

: » (comma)
} (semicolon)
SPACE
TAB

Other:

interacts with

Use first line as column names

1(C

Ignore lines starting with:

* Ignore lines starting with. You can indicate a character, e.g. ‘#’, to distinguish comment
lines in the import files, so that they are not treated as network data.
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When you are satisfied with the settings, press the
import button and the network will be imported. You
will see a figure that looks like the figure on right.

The values of edge attributes can be used as arguments .
to graph layout and other computational operations. In 1
the bottom example on right, the attribute for Weight
is used in the calculation of coordinate positions using
Cytoscape’s. Force-Directed Layout. '

Notes

# Cytoscape File Edit View Select Layout Apps Tools Help W O 4 100G Satd;
600 Session <

W QQAAQ W g R Y [ o

e Network 1xt

[ - S

Contol Panel
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Load Tables

In this section we will explore how to create
Cytoscape attributes and values by importing a pre-
existing text or Excel file.

Let’s begin by selecting the File -> Import -> Table
-> File... menu item. In this example, we import
the file galExpData.csv.

The graphical user interface is similar as for creating
networks and allows you to interactively specify
parsing options for the specified files. The screen
provides a preview that shows how the file will be
interpreted given the current configuration. As the
configuration changes, the preview updates
automatically.

Notes

&Y Loading Tables

» Use import table from file
— Excel file
— Comma or tab delimited text

o
la =] (=]

% Import Columns From Table — s

Target Table Data
Where to Import Table Data: [0 a Network Collection | v
Select a Network Collection
Network Collection: |galFiltered.sif v
Import Data as: Node Table Columns .
Key Column for Network: |shared name ~

Case Sensitive Key Values: [V]

Preview
Click on a column to editit. Select Al Select None
& GENE ¢« [(EBcommon ¢« [ gallRGexp <« [ ga4RGexp « [ galsoRexp
YHROSIW coxe 0,034 o111 0. a
YHR124W DT8O 0,090 0.007 o=
YKLISBIW PRS1 0.167 0.233 0=
YGRO72W UPF3 0.245 0.471 0.
YHLO20C oP1L 0.174 0,015 0.
YGR145W YGR145W 0.387 -0.577 0.«
<« — 1" »
Advanced Options...
[conet ]
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To change the default selection chosen by Cytoscape, click on the arrow in the column heading and
a dialog box will be displayed. You can change the name for the attribute. You can decide whether
the column is imported or not by selecting one of the two options: imported (&) and not imported

().

&, Import Columns From Table X

You can also set the Data type of the elements in the data e
column, to one of the primitive data types that Cytoscape o et [ ]
supports. These are String, Integer, Long Integer, Floating con ot B

Point, and Boolean. You can also set the Data type of the
column to be a list of primitive elements of one datatype. o | s

R GENE ¢« [EcOMMON <~ @ galiRGexp ¢ [Bga4RGexp ¢« [ galBORexp

common

Now you need to map unique identifiers between the
entries in the data and the nodes in the network. The key e [
point of this is to identify which nodes in the network are e
equivalent to which entries in the table. This enables
mapping of data values into visual properties like Color
and Shape. This kind of mapping is typically done by
comparing the unique Identifier attribute value for each node (Key Column for Network) with
the unique Identifier value for each data value (&). As a default, Cytoscape looks for an attribute
value of ‘ID’ in the network and a user-supplied Key in the dataset.

: <471
0,015
( ° S [E] o577

ok [canl

The Key Column for Network can be changed using a combo box and allows you to set the node
attribute column that is to be used as key to map to. The user can change the Key by pressing the
key button (&) for the column that is to be used as key for mapping values in the dataset.

If there is a match between the value of a Key in the dataset and the value the Key Column for
Network field in the network, then all attribute-value pairs associated with the element in the
dataset are assigned as well to the matching node in the network.

Under the Advanced Options section, you will see a set of checkboxes appear. These allow you to
choose the:
Import - Advanced Options &Jw
* Delimiter. The delimiter character that separates File Import Options
columns (fields) in the import file. This can be a tab, pelimier: (V]
comma, semicolon, space, or any arbitrary delimiter 7 (okrion)
character that you define. e
* Column Names. You can choose whether to use the other:
first line of the file to supply column names, one name 7] Use first ine as column names
per delimited column in the file. Stort Import Row: |_ 115
e Startimportrow. You can set the import line number rerelnes sertna
so that you can skip over any initial header or
comment lines in the file. 1
* Ignore lines starting with. You can indicate a
character, e.g. ‘#’, to distinguish comment lines in the
import files, so that they are not treated as network data.
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Once attributes are imported, we can inspect them in =~ oo -
the Table Panel. Right clicking on the 0 icon in the L LS ==
toolbar will bring up a menu of checkboxes. If you e — \ fe

check a checkbox for any attribute in that attribute
list, its values will be displayed as a column of values
on the Table Panel. The attribute list also contains
information about the Data type of each column and
if it belongs to the whole network collection or only
to the current network.

If you a select a node in the network, its attribute I
values will be displayed in the control panel, but by

default, if no nodes are selected, all attribute rows are
shown.

Notes
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Tips and Tricks

Cytoscape is a large, complex, and dynamic
software system. A little knowledge of the
internals organization and operational model of
the software will enable more efficient use of the
software. Here are some useful Tips & Tricks to
help you get the most out of your Cytoscape usage.

The ’"Root Graph”

There is one central root graph that contains all
nodes and edges. Thus all networks are ‘views’ on
that single graph, and nodes and edges are unique
across all networks. Modifying a node in one
network will modify that node in all other
networks that it appears in. There is no way to
have two or more copies of a node with the same
ID. The only workaround would be to make a copy
of a Cytoscape session.

Network Views

For efficiency in dealing with large networks, a view
is not automatically generated when the size of the
network is over a user-definable threshold. You
can manually generate a Network View by right-
clicking on its entry in the Network Navigator Panel
(upper left o Cytoscape desktop)., then selecting
‘Create View’. You can also use that right-menu
item to ‘Destroy View’, ‘Destroy Network”, and edit
the Network’s title.

Tips & Tricks

* Network Collections

— Each collection has a “root” network

— Changing the attribute for a node in one
network will also change that attribute for a
node with the same SUID in all other networks
within the collection

—You can clone a network into a new collection
to “decouple” it and start a new root

oY Tips & Tricks

» Network views
— When you open a large network, you will not get
a view by default
— To improve interactive performance, Cytoscape
has the concept of “Levels of Detail”

» Some visual attributes will only be apparent when
you zoom in
» The level of detail for various attributes can be
changed in the preferences
* To see what things will look like at full detail:
— View->Show Graphics Details

55

To improve interactive performance, Cytoscape has the concept of Levels of Detail? This is

basically a mechanism for semantic zooming,
where different levels of detail com into play at
different levels of detail (think of the Google Maps
interface where a City is represented by a yellow
patch at high level then shows more of the
structure of streets and avenues as you zoom in.

Some Cytoscape attributes will only be apparent
when you zoom in. The level of detail for various
attributes can be changed in the preferences. To
see what things look like in full detail, select the
View-> Show Graphics Details menu item..

<’ Tips & Tricks

» Sessions

— Sessions save pretty much everything:
* Networks
* Properties
+ Visual styles
+ Screen sizes

— Saving a session on a large screen may require

some resizing when opened on your laptop
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Sessions

Sessions save pretty much everything: Networks, Properties. Visual styles, Screen sizes, and many
other types of information. When working on a complex study of workflow, it is often prudent to
save one’s intermediate results as a session, so that the current state of an activity is persisted and
can be resumed without having to repeat earlier low-level operations.  Not all state is the same,
however. For example, saving a session on a large screen may require some resizing when re-
opened.

Task Monitor

The Cytoscape task monitor will show the N Tips & Tricks
messages for the current task and all of the
completed tasks. You can show the task + Task monitor
monitor by clicking its icon in the lower left- — Current task displayed in status bar (lower left)
hand corner. — Icon opens complete task history

* Memory
Cytoscape will also log more detailed messages — Current status (lower right)

— Toggle open for details and “Free Unused

to the framework-cytoscape.log file in Memory” button

CytoscapeConfiguration/3 directory.

Memory

Cytoscape uses a lot of memory and, as a Java -

system, doesn’t like to let go of it. When

working with large networks, an occasional save

session and restart will help clear out memory. Another efficiency measure is to destroy large
network views when not needed.

Cytoscape now provides a memory indicator in the lower right-hand corner of the window. This
will tell you if you have enough memory (green) or you are running out of memory (yellow, red).
Details are available by clicking the button and you will be given the option to “Free Unused
Memory” to lower memory as much as possible.
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Final points on Tips and Tricks

P
. . . PN i i
« CytoscapeConfiguration directory } Tips & Tricks
— This directory is typically located under * CytoscapeConfiguration directory
h di f ] — Your defaults and any apps downloaded from the
your home directory, for example on a App Store will go here
Macintosh system it will be under « App Manager
— This is where you search/install/update/uninstall
/Users/<username> apps
— You now have the option of disabling vs.

uninstalling...

— Your defaults and any pluglns downloaded — Can also install and update apps directly from the

from the app manager will g0 in this App Store website, if you have Cytoscape 3 up and
directory. Also, apps may use this directory running
to store configuration -

— Sometimes,, if things get really messed up,
deleting (or renaming) this directory can give you
a “clean slate”

* App manager
— This is where you search/install /update /uninstall apps
— You now have the option of disabling vs. uninstalling...

— Can also install and update apps directly from the App Store website, if you have Cytoscape
3 up and running

Notes
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Demo/Sample use cases

Usg case 1: ExPre§S|on data Ianalys.ls s Expression Data Analysis
This use case highlights the visual display of
expression data, integrated clustering features, + Load galFiltered.cys
: : » Explore the expression fold changes: galIRGexp,
and basic Gene Ontology overrepresentation gal4RGexp, and gal80Rexp. The network is colored by
analysis. Note: we are starting with an expression galdRGexp values.
. » To explore the expression profile for these three
dataset that has already been normallzed, deletions, we can use clusterMaker to do a hierarchical
. . cluster
statistically analyzed, formatted, imported and "~ Apps—>clusterMaker->Hierarchical
associated with an interaction network. — Choose the attributes we’re interested in (node.gall RGexp,

node.gal4RGexp, node.gal80Rexp)

— Choose the type of clustering (pairwise average-linkage, Euclidean
The dataset _ Clck “Show TreeView when complete
Differential gene expression of GAL deletion - ClickOK
mutants grown in the presence and absence of o
galactose[127]. Fold values were mapped onto a
protein-protein interaction network focusing on
galactose utilization in yeast, Saccharomyces
cerevisiae. Additional annotations (e.g., gene and
protein identifiers, GO terms, pathway
associations, etc) have also been added as node
attributes. This dataset is included with the
download of Cytoscape in the sampleData folder

and is called galFiltered.cys.

Locate and open the galFiltered.cys session file.
Check out the VizMapper settings for node color.
By default, the nodes are colored by the fold value
gal4RGexp. Explore the visualization of other fold
values in the dataset: gal1RGexp and gal80Rexp.

Notes
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8 00 Hierarchical cluster

CIUSter anaIySis Linkage | pairwise average-linkage
To explore the expression profiles for the three deletions, we e
can perform clustering within Cytoscape using the [
clusterMaker app. e

gal4RGexp

gal4RGsig

; :
In the Apps menu, select clusterMaker > Hierarchical. Py
Edge column for cluster | --None--
. Clustering Parameters
* Choose the type of c]usterlng; O e ) s (s -
. . . Cluster attributes as well as nodes ™
O pairwise average-linkage T e ]
* Choose the attributes of array data: pore e

Create groups from clusters ~
O no de.gal 1 RGeXp Show TreeView when complete @

o node.gal4RGexp

o node.gal80Rexp
* Check Show Treeview when complete
¢ (lick: OK

OK Cancel |

This will bring up the TreeView of your cluster results.
Each row is a gene and the three columns correspond to
the three data attributes. A dendrogram to the left
expresses the relationship between clusters, and the
region to the right shows a close-up and labeled view of
selected rows.

If the colors are too dark, or if you prefer other colors
altogether, you can open Settings... and adjust a number
of preferences.

=
fiero1oc
laRa12c
ERezow

Now, select the top most branch of the dendrogram, as
shown on the right. Notice that selections in TreeView
correspond to selections in the network!

Notes

(setings. ) (saveata ) (_ExportGraphics. ) (_Map Colors OntoNewwork. ) (_Close )
Settings.. Save D Export Graphics. Map Colors Onto Network- a
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GO term overrepresentation analysis

Now we can see if any of the selected genes from
that first cluster show any GO term
overrepresentation. In other words, are there
particular GO terms that are enriched (or
overrepresented) in this subset of genes? We can
do this using the BiNGO app.

¢ Apps>BiNGO

* Give the cluster a name

* C(Click: Start BINGO

* Note: there are many parameters you can
play with. The defaults are usually sufficient
for a first pass as major trends.

The results are displayed as a table and as a
network of GO associations. The GO terms are
connected based on their inherent hierarchical
relationship and they are colored based on the
significance of their overrepresentation in your
cluster.

Notes

&

Expression Data Analysis

Now we can see if these genes show any GO
overrepresentation

Start BINGO

— Apps~>BINGO

— Give the clusters a name (e.g. clusterl)

Click on Start BiNGO to process the data

The results include a table and a network of GO
associations

In this case the top term is “galactose catabolic
process via UDP-galactose,” which makes good

sense
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Expression Data Analysis

Active modules
Using the jActiveModules app, we can also identify ,
. . . * Active modules

clusters that show differential expression over user- o L

s L. . . . — The jActiveModules app identifies clusters that show
spec1f1ed conditions or time-points. Here, we will differential expression over user-specified conditions
use the p-values for the differential expression of or time-points
the GAL deletion mutants. — Go to the jActiveModules tab in the Control Panel

* Select the galFiltered.sif interaction network
* Select the attributes that contain the gene expression p-

* Select the jActiveModules tab in the Control values: gal IRSig, gal4RSig, galSORSig
Panel * Click Search
¢ Choose the galFiltere d.sif interaction — Explore the resulting networks in the overview

— Apply BiNGO on one of the active modules
network ,

¢ (Choose the attributes that contain the
differential expression p-values:

(@] gallRSlg, Control Panel 0O x
O gal4RSlg [ o netwark | style [ select | sets| jactivenniodules
. Target Network
O galSORSIg |gailteredsif |
L[] Chck Search Numeric Node Attributes
Name Most sig Least sig Reverse sig  Scaling
! gallRGex] -2.426 2.058 rankiu... ¥
This will invoke the creation of several new ity 5 : R
. .« e adialif R -
networks: one for each cluster identified by fgoirep S — i
. . . ! NeighborhoodConnec... rankfu... v
jActiveModules and one overview network of all EcaliRCon Zaosl 1224 I
modules. Each node in the overview network has a e T R
. ) ClusteringCoefficient 0 1 -
node score that shows how significant S
the identified module is and the edges

are weighted by the number of nodes
they share. Each module network has
the same attributes as the original

¥5L0380))

FRotEc>
< Rozon>

oLostw>

network and we can look at the A Module-0.5
significance values in the Node Table "\
panel.
2 Module 0.4 o

Notes

|2/ Module_0.4

-/
@& IcL1 FBP1

Table Panel ox

% [0 ov oo O @ = f(z) Modueos

|

i | iFed | e eFel | gus]  GETD T IR
ooy | onses  oiss  Oseoi o oowws ST Ao T —
I S A /4 - Y AT
T Y N — A : ‘

S e e S5 oen | s o7 | sewiEi| oz
065 | 193l 0591 | 4ss0ies 1147 | adees 5 0652 | 4.934266 0541 | 4095867 0815
BT R T - A A AR A A
Sonl ieeul osel ommes| os| izes| | 7 oue | sk am| resEal 0%
0.223 2.950%- 0311 5.3674€- 0.258 15| 0183 | 0.0035372 | -0.654 4.2514E6. 0.457.
0.186 7.2553-4 | -0.26 1.85826~ 0.957 5.2368E-11 - 16 | 0.082 0.045195 0.014 0.79134 -0.573
[ M 15 | 0.037 0.72668 0.169 0.55601 0.442

Nade Table | Edge Table | Network Table|

Revised 05/26/2016



Revised 05/26/2016



Use case 2: Protein complexes in protein-

protein interaction networks s Protein Complexes
This use case highlights the combined use of MCL

clustering of protein-protein interaction (PPI) + Load collinsPlus.cys

networks and hierarchical clustering of epistatic it o oot Combined S TAP Y P etk o
mini-array profile (EMAP) data to explore o6 e Yeust EMAP

potential biological protein complexes.

The dataset

We will be working with a Cytoscape session file
containing three networks: one is a yeast PPI[27]
and the other two are yeast EMAP datasets [7,
128]. Note: we will not bother viewing the EMAP
datasets as networks, but rather treat them as sets
of nodes and attributes. You can perform clustering
on sets of nodes without creating a network

+ RNAPuberNov2+Meg6e.csv: Yeast EMAP

view! The key to making this analysis work is LECECE Rw 8aad & bew i

x feco

combined_scores_good.oxt

having the same node identifiers in both the
PPl and EMAPs.

The dataset is provided with this tutorial and
is called collinsPlus.cys:

* combined_scores_good.txt (PPI)

* DNAand Tran 07-21-06b.csv (EMAP)
* RNAPuberNov2+Meg6c.csv (EMAP)

(ETIEETN e Table | Nework Tabie |

Notes
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6006 MCL Cluster
Basic MCL Tuning

MCL clusters in the PPI network ity s o )
First, we will identify the MCL clusters in the protein- e 2
protein interaction network. Under the Plugins menu, Saoeweiht conersion ( o
choose Cluster and then MCL cluster: s cutet —
* Density Parameter: 1.8 e Y
* Array source: PE Score P o
* Check Create new clustered network and Restore ey
inter-cluster edges after layout e — “
* (lick: OK - =

There are your MCL clusters. Beautiful,
aren’t they! These are our first e T e [aTatein T e
approximation of potential protein 5 e .
complexes based solely on tightly

interacting protein clusters.

Next, we consider the clusters generated
from EMAP data as an orthogonal form of
evidence based on genetic interactions.
Combining both cluster results provides a
more complete picture.

Notes
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Hierarchical clustering of EMAP data

Select the “DNA and Tran...” dataset in the Network
panel on the left. Note: the red highlight simply
indicates that no network view has been created. No
problem. Once again, go to Apps > clusterMaker >
Hierarchical Cluster:

* Linkage: pairwise average-linkage

* Distance Metric: Uncentered correlation
* Edge column for cluster: DNA Strenth

* Check: Show TreeView when complete
* C(lickOK

|00 clusterMaker TreeView : DNA and Tran 07-21-06b.csv.

View stat|[ 1 N Usage Hints
Select Click to select node

Settings... | saveData. | | ExportGraphics.. | Flip Tree Nodes. | Map Colors Onto Network... | Close

8 00 Hierarchical cluster

- use arrow keys t¢ f o @F @ @E N W =

Linkage | pairwise average-linkage

Distance Metric | Uncentered correlation

Array sources
Node attributes for cluster
None—— |
0_MCL_cluster
GPL51-01 (GSM854) heat shock 05 min
GPL51-02 (GSM855) heat shock 10 min
GPL51-03 (GSM856) heat shock 15 min
GPL51-04 (GSM857) heat shock 20 min
GPL51-05 (GSM864) heat shock 20 min repeat
GPL51-06 (GSM865) heat shock 40 min

Edge column for cluster | DNA Strength gl

Clustering Parameters

Only use selected nodes/edges for cluster

Cluster attributes as well as nodes

KA

Ignore nodes/edges with no data
Advanced Parameters p

Visualization Options
Create groups from clusters U

Show TreeView when complete v

| ok | Cancel |

500

The EMAP clusters identify potential complexes based on genetic (functional) interactions. Now,
we can explore the correspondence of evidence from these two methods. For example, search for
GIMS and select the entire cluster. Notice how the corresponding interactions are dynamically
highlighted in the TreeView. Notice how both EMAP and PPI data do not provide strong support

for the inclusion of BUD27 in this potential complex.

Notes

Revised 05/26/2016




Hands-on tutorial: Introduction to Cytoscape

This tutorial will cover:

Navigating Cytoscape
Visualizing Data on Networks
Network and Pathway Resources
Plugin Manager

Plugin Demos

SANL I

By the end of the tutorial, you should be able to use Cytoscape to import networks and attributes
and visualize those attributes on the network.

Notes
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Hands-on tutorial: Working with data

This tutorial will introduce you to:

1. Searching Internet interaction databases with query terms.
2. Mapping Identifiers of different types to networks.
3. Finding your query terms in the downloaded network.

The second half of the tutorial will introduce you to some advanced basics in Cytoscape:

1. Apply filters to filter out low-confidence edges.
2. Perform basic edits using the Cytoscape graph editor.

Notes

Revised 05/26/2016



Hands-on tutorial: Analysis of microarray data

This tutorial will introduce you to:

1. Combining data from two different sources: experimental data in the form of microarrray
expression data and network data in the form of interaction data.

2. Visualizing networks using expression data.

3. Filtering networks based on expression data.

NOTE: The expression data used in this example has been pre-processed to work with the
interaction network used.

Notes
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